
Quick Start Guide
Metric Units

Arrow Version 11
Compressible Pipe Flow Modeling

Published: July 07, 2025



CAUTION!

Arrow is a sophisticated pipe flow analysis program designed for qualified
engineers with experience in pipe flow analysis and should not be used by
untrained individuals. Arrow is intended solely as an aid for pipe flow analysis
engineers and not as a replacement for other design and analysis methods,
including hand calculations and sound engineering judgment. All data generated
by Arrow should be independently verified with other engineering methods.

Arrow is designed to be used only by individuals who possess a level of
knowledge consistent with that obtained in an undergraduate engineering course
in the analysis of pipe system fluid mechanics, have been trained in the
specialized field of gas dynamics, and are familiar with standard industry
practice in pipe flow analysis.

Arrow is intended to be used only within the boundaries of its engineering
assumptions. The user should consult the Arrow Help System for a discussion of
all engineering assumptions made by Arrow.

Information in this document is subject to change without notice. No part of this Quick Start
Guide may be reproduced or transmitted in any form or by any means, electronic or mechanical,
for any purpose, without the express written permission of Applied Flow Technology.

© 2025 Applied Flow Technology LLC. All rights reserved.

“AFT Arrow”, “Applied Flow Technology”, “Dynamic solutions for a fluid world”, and the AFT
logo are trademarks of Applied Flow Technology LLC.

Excel and Windows are registered trademarks of Microsoft Corporation. Chempak is a trademark
of Madison Technical Software, Inc. REFPROP is a trademark of the National Institute of
Standards and Technology (NIST). CAESAR II, SmartPlant, CADWorx, and PDS are trademarks
of Intergraph Corporation / Hexagon AB. AutoCAD Plant 3D is a trademark of Autodesk, Inc.
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C H A P T E R 1

Introducing Arrow

Welcome to Arrow, Datacor’s powerful compressible pipe flow modeling tool.
With Arrow you can model compressible flow in complex pipe networks, and
include the complicated effects of real gas behavior, heat transfer, gas mixing,
and sonic choking at one or more locations. In addition, it includes steam
property calculation from respected sources such as the ASME Steam Tables.
These capabilities will allow you to properly understand the behavior of your
gas system.

Arrow performs a complete mass, momentum, and energy balance on your pipe
system. It implements a sophisticated solution engine that marches down pipes,
offering superior accuracy to commonly used lumped methods.

Arrow has three available Add-on Modules for purchase which extend the
modeling capabilities into new areas.
� The Goal Seek & Control (GSC) module allows the engineer to perform

multivariable goal seeking and simulate control system functions.
� The Extended Time Simulation (XTS) module allows the engineer to model

time-varying system behavior via a series of steady-state snapshots.
� The Automated Network Sizing (ANS) module automates the process of

sizing pipes and ducts in a complex network based on design requirements,
such as maximum pressure or minimum flow, to reduce cost or weight.

Modeling capabilities

Standard version capabilities
� Open and closed (recirculating) systems

� Network systems that branch or loop, with no limit on the number of loops

� Pressure-driven systems

� Compressor or fan-driven systems, including multiple compressors/fans in
parallel or in series

� Compressors/fans with variable speed, controlled pressure, controlled flow,
and a fixed compression ratio

� Systems with pressure and/or flow control valves
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� Systems with valves closed and/or compressors/fans turned off

� Heat transfer analysis and system energy balance

� Systems with real gases

� Systems that experience sonic choking, including multiple sonic choking
points

� Systems with non-reacting flow stream mixing with NIST REFPROP (or
with optional Chempak add-on)

� Systems with elevation changes or rotation such as in turbomachinery

Add-on module capabilities (optional modules may be
purchased separately)
� Multivariable goal seeking and control simulation (GSC)

� Time-varying system modeling (XTS)

� Valves opening and closing over time (XTS)

� Compressors/fans starting and stopping over time (XTS)

� Automated design of piping networks (ANS)

Arrow provides hundreds of standard loss coefficient values from handbook
sources for pipe system components, and also allows the engineer to enter their
own loss data. Variable loss models that depend on flow are supported.

Arrow provides two independent solution methods (length and Mach number
march) that can be run individually or in combination with each other to allow
flexibility and cross-verification of results. In addition, Arrow offers two lumped
methods (adiabatic and isothermal) that offer improved computation speed with
a slight loss in accuracy. Sonic capabilities allow modeling of high velocity
conditions such as in relief systems.

Arrow allows you to change the gravitational acceleration of the system, a
feature useful for aerospace vehicle applications or pipe systems that are
designed for extraterrestrial environments.

Engineering assumptions in Arrow

Arrow is based on the following fundamental fluid mechanics assumptions:
� Compressible flow

� Steady-state conditions (XTS Module consists of steady snapshots)

� One-dimensional flow

� System is fluid-full

� All gases are superheated (single phase)

� No chemical reactions

� No supersonic flow in the system
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Thermophysical property data

Arrow offers several sources from which thermophysical properties can be
derived:
� ASME Steam Tables - Properties are calculated with the equations of state

from the IAPWS Industrial Formulation (1997), also used to generate the
ASME steam tables.

� Chempak™ - Optional add-on for purchase which contains data for
approximately 600 gases and supports user-specified fluid mixtures.
Chempak is licensed from Madison Technical Software.

� NIST REFPROP - The Reference Fluid Thermodynamic and Transport
Properties Database is licensed from the National Institute of Standards and
Technology (NIST) where properties for approximately 150 fluids are
calculated via equations of state. REFPROP supports user-specified fluid
mixtures.

� Arrow Standard - Common fluids from various industry standard sources
have been curve fit to optimize calculation speed.

� User Library Fluid - A custom fluid can be saved to the User Library for
repeated use in the future.

NIST REFPROP and Chempak support two types of gas mixing: static mixtures
and dynamic mixtures. Static mixtures are user-defined and established prior to
running the model. Dynamic mixtures form when flow streams of different
compositions combine, resulting in a new mixture whose composition is
determined by the relative flow rates and compositions of the incoming streams.
The simulation updates the composition of dynamic mixtures as it progresses.
All gas mixtures are treated as non-reacting.

Arrow can model a large range of gases including steam, natural gas, air,
chemical, and petrochemical process gases. Support for real gases is offered
through several generalized equation of state models, the ASME Steam Tables,
the NIST REFPROP fluid library, or with optional Chempak add-on fluid
library.

Arrow Primary Windows

Arrow has several Primary Windows that work in an integrated fashion. Each is
located on a separate, moveable tab. The majority of work will be done in one of
these windows and the menu dropdown options are dependent on which window
is loaded. For this reason, they are referred to as Primary Windows.

Workspace
The Workspace Primary Window is where the user creates the graphical
representation of the system. Engineering data is input on pipe and junction
property windows which are opened by double-clicking the objects.
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The Workspace Layers are also located on this Primary Window and allow the
user to display both input and output data superimposed on the pipe system
schematic.

Model Data
The Model Data Primary Window summarizes the engineering input data from
the Workspace into categorized tables. This allows for easy review of the system
inputs, and double-clicking cells will open the pipe or junction properties for
quick editing.

Output
The Output Primary Window offers a powerful and diverse range of features for
reviewing analysis results which are organized into categorized tables and lists.
The Output allows the user to easily compare multiple design scenarios with
color coded rows, details errors or design requirement violations, and prepare
the results for documentation.

Graph Results
The Graph Results Primary Window allows the user to create a wide array of
graphs with various parameters which are integral to gaining a deeper
understanding of the pipe system’s behavior. The user can adjust various
formatting settings such as axis ranges, labels, colors, and create dual y-axis or
stacked graphs. The settings can be saved into templates called Graph List Items
so that the graphs can be easily reproduced.

Input vs. Output
Table 1.1 summarizes how each Primary Window relates to input and output
data. The Workspace can display output data by using Workspace Layers after
the simulation has been run.

Table 1.1 Primary Window Input vs. Output Data

Primary Window Can Display Input Can Display Output

Workspace ✓ ✓

Model Data ✓

Output ✓

Graph Results ✓
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Note: Arrow supports multiple monitors. You can click and drag any of the
Primary Window tabs off of the main Arrow window, where it can then be
moved anywhere on the screen, including onto a second monitor. To add the
Primary Window back to the main Arrow program window bar, simply close the
Primary Window.

Note: To ensure that your results are the same as those presented in this
documentation, these examples should be run using default settings, unless you
are specifically instructed to do otherwise.
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C H A P T E R 2

Orifice CdA & Sonic Choking Example

This example demonstrates a sample calculation to determine the maximum
flow through a system where sonic choking occurs.

Topics covered
� Model building basics

� Entering Pipe and Junction data

� Specifying Analysis Setup

� Specifying Output Control

� Using Workspace Layers

� Graphing results

Required knowledge

No prior knowledge is required for this example.

Model file

This example is intended to be built from scratch to help familiarize yourself
with the steps to define a complete model in Arrow. For reference purposes
only, the completed example model file can be found in the Examples folder as
part of the Arrow installation:

C:\Users\[username]\Documents\Datacor\Arrow 11\Examples
� Metric - Orifice CdA and Sonic Choking.aro

Problem statement

For this problem, steam flows from one tank to another, through an orifice.

The first pipe from the inlet tank to the orifice is 3 meters long and the second
pipe leading from the orifice to the discharge tank is 6 meters long. Both pipes
are Steel - ANSI, 2-inch, STD (schedule 40), and they are perfectly insulated
(adiabatic).
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The inlet tank has a pressure of 16 barG, and a temperature of 260 deg. C. The
discharge tank has a pressure of 0 barG. The elevation of both tanks is 0 meters.

The orifice at the end of the first pipe has an area of 20 cm2 and a K Factor of
10.

Determine the following:
1. What is the flowrate through the system?

2. What is the stagnation pressure at the exit?

3. At the maximum flow, what is the sonic area at the orifice? At the
discharge tank?

Step 1. Start Arrow
► To start Arrow, open the all applications list in the Windows Start Menu,

expand the Arrow 11 folder, and choose Arrow 11 to launch the application.
This refers to the standard menu items created by a standard installation.

As Arrow starts, the Arrow Startup window appears, as shown in Figure 2.1.
This window provides you with several options you can choose before you start
building a model.

Figure 2.1 Startup Window with Modeling Preferences Collapsed

Some of the actions available are:
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� Open a recent model, browse to a model, or browse to an example

� Activate an Add-on Module

� Select the working fluid, such as Arrow Standard Air or a recently used
fluid

� Review or modify Modeling Preferences: select a Unit System, filter units,
choose a Grid Style, select a Default Pipe Material, and more

� Access other Resources such as Help Files and Video Tutorials

If this is the first time that you have started Arrow, Modeling Preferences will be
expanded in the middle section of the Startup Window, as shown in Figure 2.2.
If this is not the first time that you have started Arrow, the Startup Window will
appear with Modeling Preferences collapsed, as shown in Figure 2.1.

When collapsed, you can view your current Modeling Preferences at the bottom
of the Start a New Model section. To further review or adjust your preferences,
click the Modify button (see Figure 2.1).

Figure 2.2 Startup Window with Modeling Preferences Expanded

► With Modeling Preferences expanded, as in Figure 2.2, select Both with
Metric Defaults under Unit System. The Filter section can be used to limit the
number of units that are shown in the interface.

The Common Plus Selected Industries option adds units from the industries you
select. You can use the Show Sample Units option to see the model units based
on your selections. After modifying your Modeling Preferences, click
Remember My Preferences and Hide.

► Click Start Building Model.

8 Arrow 11 Quick Start Guide



The Workspace window is shown initially, as seen in Figure 2.3. The tabs in the
Arrow window represent the Primary Windows. Each Primary Window contains
its own toolbar that is displayed directly beneath the Primary Window tabs.

The Workspace window
The Workspace window is the Primary Window for building your model. This
window has three main areas: the Toolbox, the Quick Access Panel, and the
Workspace itself. The Toolbox consists of the object icons on the far left. The
Quick Access Panel is on the far right and gives easy access to the Scenario
Manager, object Properties, and Workspace Layers.

Figure 2.3 The Workspace Primary Window

You will build your model on the Workspace using the Toolbox. The Pipe
Drawing tool on the upper-left is used to draw new pipes on the Workspace. The
Annotation tool beside it allows you to create annotations and auxiliary graphics.

Below the two drawing tools are the different types of junctions available in
Arrow. Junctions connect pipes and influence the pressure or flow behavior of
the pipe system. Drag and drop any of the junction icons from the Toolbox to
add them to the Workspace.

Holding your mouse pointer over a Toolbox icon identifies the tool’s function.

Hiding the Quick Access Panel
By default, the Quick Access Panel is pinned to the Workspace window so it is
always displayed. The Quick Access Panel can be unpinned so it is only
displayed when the mouse is moved over a tab displayed on the right edge of the
Workspace window. Unpin the Quick Access Panel by clicking on the pin icon
displayed in the top right corner of the Quick Access Panel (see Figure 2.3). The
Quick Access Panel will be pinned for the remainder of the examples in this
guide.
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Step 2. Build the model

To lay out this example model, you will place several junctions on the
Workspace. Then, you will connect the junctions with pipes.

A. Place a tank
► To start, drag a Tank junction from the Toolbox and drop it on the

Workspace. Figure 2.3a shows the Workspace with one tank.

Objects and ID numbers
Items placed on the Workspace are called objects. Arrow uses three types of
objects: pipes, junctions, and annotations.

All pipe and junction objects on the Workspace have an associated ID number.
Junctions are prefixed with the letter J, and pipes are prefixed with the letter P.
You can assign a name in the object’s Properties window, and the visibility of
both the name and ID number can be controlled through the use of Workspace
Layers. You can also drag the ID number/name text to a different location to
improve visibility.

The tank you have created on the Workspace will take on the default ID number
of 1. You can change this to any desired integer between 1 and 99,999 that is
not already assigned.

Editing on the Workspace
You can move junctions on the Workspace to new locations. You can also cut,
copy, paste, and duplicate junctions from the Edit menu or using keyboard
shortcuts. Undo is available for most arrangement actions on the Workspace.

Figure 2.3a Walk through model with the first junction placed
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B. Place the other junctions
Drag an Orifice junction from the Toolbox and drop it to the right of the Tank
junction (see Figure 2.3b).

If a new junction type you want to add already exists on the Workspace, you
have the option of duplicating that junction. You do this by choosing Duplicate
from the Edit menu or by using CTRL+D. Either duplicate the first tank, or drag
a new Tank junction onto the Workspace. Place the new tank to the right of the
Orifice junction (see Figure 2.3b).

Note: The relative location of objects in Arrow is not important. Pipe lengths
and junction elevations are defined through property windows. The relative
object locations on the Workspace establish the connectivity of the objects but
have no bearing on the actual length or elevation relationships. The Isometric
Pipe Drawing Mode (see Chapter 3) can be used to visually represent the three-
dimensional nature of a system.

Icon placement on the Workspace does not impact results. Only the connections
between objects and the associated input data are included in the calculations.
However, aligning icons can improve the visual clarity of the model. Use the
Align feature in the Arrange menu to align icons.

The model should now appear similar to that shown in Figure 2.3b.

Figure 2.3b Walk through model with all junctions placed

► Before continuing, save your work. Press CTRL+S, use the Save button on the
Common Toolbar, or go to the File menu and select Save. Arrow models use the
*.aro file extension.
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C. Draw a pipe between J1 and J2
Now that you have all of the junctions placed, you need to connect them with
pipes.

Connecting Junctions with Pipes
► To create a pipe, click the Pipe Drawing Tool icon on the Toolbox. The mouse

pointer will change to a crosshair when you move it over the Workspace. Click
and drag to draw a pipe below the junctions, similar to that shown in Figure
2.3c.

The pipe object on the Workspace has an ID number (P1) that is shown near the
center of the pipe.

Figure 2.3c Walk through model with the first pipe drawn

► To place the pipe between J1 and J2, use the mouse to grab the pipe in the
center, drag it so that its left endpoint falls within the J1 Tank icon, then drop it
there (see Figure 2.3d). Next, grab the right endpoint of the pipe and stretch the
pipe, dragging it until the endpoint terminates within the J2 Orifice icon (see
Figure 2.3e).
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Figure 2.3d Walk through model with the pipe partially connected

Figure 2.3e Walk through model with the first pipe connected
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Reference positive flow direction
The arrow on each pipe indicates the reference positive flow direction for the
pipe. The direction does not influence the direction that the flow may go, it
influences sign convention only. If the direction of flow calculated by the Solver
is the opposite of this reference flow direction, then the output will show the
flow rate as a negative number.

You can reverse the reference positive flow direction by choosing Reverse
Direction from the Arrange menu, selecting the Reverse Pipe Direction button
on the Toolbar, or pressing F3.

Although the reference positive flow direction does not need to point in the
direction of the actual flow, when used with compressors, the reference direction
determines the suction side and discharge side of the compressor.

Note: Examples of other junctions that depend on pipe directions include
Control Valves, Check Valves, and Area Changes.

D. Add the remaining pipe
For faster placement, draw the pipe directly between the two junctions.

► Activate the Pipe Drawing Tool again, position the mouse pointer on the J2
Orifice, then press and hold the left mouse button. Stretch the pipe across to the
J3 Tank, and then release the mouse button. Your model should now look
similar to Figure 2.3f.

At this point all the objects in the model are graphically connected. Save the
model.

Note: Some users find it desirable to lock objects to the Workspace once placed.
This prevents accidental movement and disruption of the connections. You can
lock all the objects by first selecting all objects by using CTRL+A or the Edit
menu by clicking Select All. Then use CTRL+L or go to the Arrange menu and
selecting Lock Object. The lock button on the Workspace Toolbar will appear
depressed, indicating it is in an enabled state. Alternatively, you can use the grid
feature and snap to grid. The grid options can be modified through the Arrange
menu or User Options window.
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Figure 2.3f Walk through model with all objects placed

Step 3. Specify Analysis Setup

The Analysis Setup window allows the user to define fluid properties, view
undefined pipe/junction properties, adjust solution control, enable Add-on
Modules if purchased and available on the current license, and specify other
simulation settings from a single central location.

► Click Analysis Setup on the common toolbar. This opens the Analysis Setup
window (see Figure 2.4). The Analysis Setup window contains seven or more
groups depending on which Add-on Modules you may be using. Each group has
one or more items. A fully defined group has every item within it defined with
all required inputs. Every group needs to be completed to run the solver. A
group or item that needs more information will have a red exclamation point to
the left of the group or item name. After completing a group, the group icon
shows a green circle with a checkmark. After defining all groups, thus
completing the Analysis Setup, the Model Status light in the lower-right corner
turns from red to green.

A. Modules
Under the Modules group, click on the Modules item to open the Modules panel,
shown in Figure 2.4. Here you can enable and disable Add-on Modules if they
are available on the license. These Add-on Modules include Goal Seek &
Control (GSC), Extended Time Simulation (XTS), and Automated Network
Sizing (ANS). By default, the model will have all modules disabled. Make no
changes to this panel for this example.
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Figure 2.4 On the Modules panel, you can enable or disable any module

B. Fluid Properties
The Fluid Properties group contains the Fluid panel where the fluid used in the
model is defined.

You can select a fluid from the Arrow Standard fluid library, select ASME
Steam, select multiple fluids and/or create mixtures using the NIST REFPROP
library (included in Arrow) or the Chempak library (an optional add-on to
Arrow), or create custom fluids. Custom fluids are created by selecting Edit
Fluids from the Library menu or by clicking the Edit Fluid List button in the
Fluid panel, and can be selected from the User Library.

► Click on the Fluid item to open the Fluid panel (see Figure 2.5). For this
example, use the Arrow Standard fluid library and select “Steam” in the upper
list, then click the “Add to Model” button below the list. Leave the Equation of
State model as “Redlich-Kwong” and the enthalpy model as “Generalized”.

Figure 2.5 Specify the fluid for the analysis in the Fluid panel
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C. Pipes and Junctions
The Pipes and Junctions group is less straightforward to define compared to the
previous two. This group requires full definition for all pipe and junction
properties. Click on the Pipes and Junctions item to open the panel shown in
Figure 2.6. Here, you will see all the undefined pipes and junctions. By selecting
a pipe or junction in the top or middle section, the remaining properties that
need definition appears in the bottom section. Select Pipe 1 for example. Pipe
Length, Pipe Inner Diameter, and Roughness/Friction needs input. To define
these parameters, you can double click on Pipe 1 from the top section, or go to
the Workspace and open the properties window from there. However, before
closing the Analysis Setup window, take a look at the final four groups.

Figure 2.6 The Pipes and Junctions panel lists the remaining undefined
objects before the model can run

D. View the final four groups
The remaining groups are Steady Solution Control, Environmental Properties,
Cost Settings, and Miscellaneous. In the Steady Solution Control group, you can
adjust the tolerance and iteration settings for the Solver; however, the default
settings will suffice for the vast majority of use cases, and caution should be
taken if editing these settings. On the Environmental Properties panel, you can
adjust the ambient pressure, gravitational acceleration, and transition Reynolds
Numbers. The Cost Settings panel allows you to select which costs to include as
well as define energy costs. The Miscellaneous group has items to specify heat
transfer sectioning, as well as change other advanced parameters. The default
selections for all of these groups will suffice to fully define these panels.

► Click OK to accept the changes in Analysis Setup and to return to the
Workspace. The remaining undefined Pipes and Junctions group requires input
before the model can run. Complete this item by opening the properties window
of the objects directly from the Workspace.
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Step 4. Define the model components

Check an object’s status to see if a pipe or junction has all the required input.

Object status
Every pipe and junction has an object status. The object status tells you whether
the object is defined according to Arrow's requirements. To see the status of the
objects in your model, click the light bulb icon on the Workspace Toolbar
(alternatively, you could choose “Show Object Status” from the View menu).
Each time you click the light bulb, “Show Object Status” is toggled on or off.

When “Show Object Status” is on, the ID numbers for all undefined pipes and
junctions are displayed in red on the Workspace. Objects that are completely
defined have their ID numbers displayed in black. These colors are configurable
through User Options from the Tools menu.

Because you have not yet defined the pipes and junctions in this sample
problem, all the object ID numbers will change to red when you turn on “Show
Object Status”.

Showing undefined objects
Additionally, you can see which remaining objects need input in the Undefined
Objects list, similar to what was shown in the Pipes and Junctions panel of the
Analysis Setup.

Open the Undefined Objects list (Figure 2.7) using the List Undefined Objects
button on the Workspace Toolbar or from the View menu by clicking on “List
Undefined Objects”. The icon on the Workspace Toolbar is located at the far
right end next to the Show Object Status lightbulb icon. This list shows all
objects with incomplete information. Clicking on an undefined pipe or junction
will display the missing property data. Click the Close button (black X icon) on
the bottom right to stop showing this window.
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Figure 2.7 The Undefined Objects list lets you see the undefined
properties for each undefined object

A. Define the J1 Tank
► To define the first tank, open the J1 Tank Properties window (Figure 2.8) by

double-clicking on the J1 icon. The pipe table should show you that Pipe P1 is
connected to this tank (click the Loss Coefficients tab to display the pipe table).

Note: An object’s Properties window can be opened by selecting the object and
then pressing the Enter key, double-clicking the object, or clicking the Open
Pipe/Junction Window icon on the Workspace Toolbar.
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Figure 2.8 Properties window for the J1 Tank

► On the Tank Model tab, enter a pressure of 16 barG. This tank will represent
the supply tank upstream of the orifice. Enter a temperature of 260 deg. C and
an elevation of 0 meters. You can assign any unit of pressure, temperature, or
elevation found in the adjacent dropdown list of units. For this example, keep
the units as specified above.

Note: You can choose default units for many parameters (such as meters for
length) in the Tools/User Options window under Preferred Units.

You can give the junction a name, if desired, by entering it in the Name field at
the top of the window. By default, the junction's name is not specified. If a
junction name is entered, it will be displayed in the Model Data, Output, and in
Workspace Layers. In Figure 2.8, the name of this tank is Inlet Tank.

You can add most junction types into a custom library. This saves the junction
inputs for repetitive use within the current model, a completely separate model,
or with another user. To select a junction from the custom library, choose the
desired junction from the Library Jct list in the junction's property window. The
current junction will get the properties from the library.

The Copy Data From Jct list at the top of the properties window shows all the
junctions of the same type in the model. This copies the user-selected parameters
from an existing junction in the model to the current junction.

Using the tabs in the Properties windows
Separate tabs in the Properties windows contain the junction information and
input fields. Click any tab to bring its information forward. Figure 2.8 is an
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example of a tank's Properties window.

Click the Loss Coefficients tab in the Properties window of J1 to show the pipe
table. The pipe table allows you to specify entrance and exit loss factors for each
pipe connected to the tank (in this case there is only one). The default selection
is for the loss factors to be specified as zero. Arrow defaults to lossless entrance
and exits. You can change the loss factors by clicking within the pipe table and
entering the loss.

The Optional tab allows you to enter different types of optional data. Depending
on the junction type, you can enter initial guesses for the Solver, specify Design
Factors, set Special Conditions (like closing a valve or turning off a
compressor), and change the junction icon.

Each junction has a tab for notes, allowing you to enter text describing the
junction or documenting any assumptions.

The highlight feature displays all the required information in the Properties
window in light blue. The highlight is on by default. You can toggle the
highlight off and on by double-clicking anywhere in the window above the tabs
or by pressing the F2 key. The highlight feature can also be turned on or off by
selecting “Highlight in Pipe and Jct Windows” on the View menu.

► Click OK. If “Show Object Status” is turned on, you should see the J1 ID
number turn black again, telling you that J1 is now completely defined.

The Inspection feature
You can check the input parameters for J1 quickly, in read-only fashion, by
using the Inspection feature. Position the mouse pointer on the J1 tank icon and
hold down the right mouse button. The inspection window appears, as shown in
Figure 2.9.

Inspecting is a faster way of examining the input (and output if results are
available) than opening the Properties window.

Figure 2.9 Inspecting from the Workspace with the right mouse button
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B. Define other junctions
► Next, open the Properties window for the J2 Orifice junction. Enter the

Orifice Type as User Specified, the Subsonic Loss Model as K Factor, K = 10,
and the elevation as 0 meters (see Figure 2.10). Click OK to close the window.

► Open the J3 Tank junction and change the name to Discharge Tank. Then
enter a pressure of 0 barG, a temperature of 260 deg. C and an elevation of 0
meters.

► Save the model again before proceeding.

Figure 2.10 Properties window for the J2 Orifice

C. Define Pipe P1
You can enter data for pipes and junctions in any order. In this example, we
defined the junctions first. Next, define all the pipes. To open the Pipe Properties
window, double-click the pipe on the Workspace.

► First, open the Pipe Properties window for Pipe P1. For Pipe P1 choose Steel
- ANSI, 2 inch, STD (schedule 40), Standard friction model, and a length of 3
meters (Figure 2.11).

The Pipe Properties window
The Pipe Properties window offers control over all important flow and heat
transfer parameters that are related to pipes.

The Inspect feature can be accessed not only from pipes and junctions located
on the Workspace, but also from within the Properties window of each pipe (and
certain junctions). This is helpful when you want to quickly check the properties
of objects that connect to a pipe or junction whose Properties window you
already have open.

To Inspect a junction connected to a given pipe, position the mouse pointer on
the connected junction’s ID number in that pipe’s Properties window (located at
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the top right of the Pipe Properties window) and hold down the right mouse
button. This process can be repeated for any junction that states the upstream
and downstream pipe in the junction’s Properties window. You can jump to that
junction’s Properties window by double-clicking the connected junction’s ID
number, or use the Jump button to jump to any other part of the model.

Figure 2.11 Properties window for Pipe P1

D. Define Pipe P2
► Open the Properties window for Pipe 2 and specify Steel - ANSI, 2 inch, STD

(schedule 40), Standard friction model, and a length of 6 meters. You will note
that the pipe size and type is remembered from the previous pipe (this can be
configured in the User Options window under Pipes and Junctions in the
Parameters section). You can also choose the “Copy Data From Pipe” dropdown
and select the parameters from any other pipe to apply to this pipe. Click OK to
save your changes.

E. Check pipes and junctions
► Check if all the pipes and junctions are defined. If all the panels in the

Analysis Setup have their required inputs, the Status Light on the Quick Access
Panel will be green. If not, view the Undefined Objects list from the Analysis
Setup, or turn on Show Object Status from the View menu, and open each
undefined pipe and junction. The Status tab on each Properties window will
indicate the missing information.

F. Review Model Data
► Before running the model, save it to file one more time. It is also a good idea

to review the input using the Model Data window.
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Reviewing input in the Model Data window
The Model Data window is shown in Figure 2.12. To change to this window,
you can click on the Model Data tab, select it from the Window menu, or press
CTRL+M. The Model Data window gives you a text-based perspective of your
model. Selections can be copied to the clipboard and transferred into other
Windows programs, saved to a formatted file, printed to a PDF, or printed out
for review.

Data displays in three sections: the General Data section at the top, the Pipe
Data section in the middle, and the Junction Data section at the bottom. Each
section collapses using the buttons at the top-left of the section. Further, each
section can be resized.

The Model Data window allows access to all Properties windows by double-
clicking on any input parameter cell in the row of the pipe or junction you want
to access.

Figure 2.12 The Model Data window shows all input in table form

Step 5. Run the model
► Select “Run Model” from the Run Model icon on the Main Toolbar or the

Analysis menu. During execution, the Solution Progress window is displayed
and can be used to pause or cancel the Solver's activity (see Figure 2.13). When
the solution is complete, click the Output button and the text-based Output
window will appear (see Figure 2.14). The information in the Output window
can be reviewed visually, saved to file, exported to a spreadsheet-ready format,
copied to the clipboard, printed to PDF, or printed out on the printer.
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Figure 2.13 The Solution Progress window displays the Solver's
convergence progress

The output file
When the Solver runs, the output data is written to a file. This file is given the
same name as the model itself with a number appended to the name, and with an
*.out extension appended to the end. For all data processing, graphing, etc., the
data is extracted from this file. The number is appended because users are able
to build different scenarios all within this model. Each scenario will have its
own output file; thus, the files need to be distinguishable from each other.

The output file will only remain on disk if you save the model after it has
been run. Once saved, it will remain until the user erases it or the model input
data is modified.

► Save the model file again such that the output file is saved to the disk. This
means that if you were to close your model right now and then reopen it, you
could proceed directly to the Output window for data review without rerunning
your model.

Step 6. Review the output

The Output window (Figure 2.14) is similar in structure to the Model Data
window. Three areas are shown, and you can expand or collapse each area by
dragging the boundary between the areas up or down, or by clicking the arrow
beside the area label. The items displayed in the tables are those items you
choose in the Output Control window.
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Figure 2.14 The Output window displays output in tabular form

This system chokes at the discharge tank. When a system chokes, Arrow will
display the “Sonic Choking” tab in the General Output section (see Figure 2.15).
This tab will appear when sonic choking occurs in the system, and will contain
messages pertaining to the sonic choking locations.

Because the flow is choked at the exit, the mass flow rate shown in the output
reflects the maximum flow rate through the system for the given inlet
conditions. The chocked flow rate through this system is 1.97 kg/sec and the
pressure at the exit is 6.63 bar (i.e., stagnation pressure at Pipe P2 outlet).
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Figure 2.15 The Output window displays the Sonic Choking tab whenever
sonic choking occurs in the system

The output in the junction data portion of the Output window shows the
Sonic Flow Area at the orifice is 8.89E-4 meters2 (8.89 cm2), and the
Sonic Flow Area at the discharge tank is 2.165E-03 meters2 (21.647
cm2). The sonic area at the discharge tank is equal to the pipe physical
area of the 2 inch, standard schedule pipe since the system chokes at the
discharge tank, and the connecting pipe, P2, has no restriction at the end.

Step 7. Customize the output

The Output Control window (Figure 2.16) allows you to select the specific
output parameters you want in your output. You can also choose the units for the
output. If you do not change any of the Output Control settings, default Output
Control parameters and a default title are assigned.

► Select Output Control from the Tools menu or the Main Toolbar to open the
Output Control window (Figure 2.16). On the Display Parameters tab, select the
Pipes button. The list of selected pipe output parameters will be displayed on the
right hand side. By default, the pipe results in the Pipes table will show pressure
in the second column with units of bar. Change the units for Pressure Stagnation
Inlet by selecting barG from the unit list shown beside the parameter.
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Figure 2.16 The Output Control window lets you customize the output

► Change the units for Pressure Stagnation Inlet by selecting barG from the
unit list shown beside the parameter.

► Click Same Units below the Output list, then click OK to change all pressure
units to barG.

► Click the Junctions button at the top.

► For the Sonic Flow Area, change the units to cm2.

► Click OK to display changes to the current results. You should see the mass
flow rate results, still in the second column, in units of kg/hr.

► Select Output Control from the Tools menu one more time. Select the Display
Parameters tab, and select the Pipes button. The Reorder scroll bar on the far
right allows you to reorder the sequence of parameters that will be displayed in
the output. You can also click on the reorder symbol on the left side of each row
to manually drag-and-drop the rows to change the parameter order (see Figure
2.16).

► Select the Velocity Inlet parameter and use the Reorder scroll bar or drag-and-
drop to move it up to the top of the parameter list.

► Click OK to display the changes to the current results. Now, you will see in
the Pipes table that the first column now contains “Vel. In”, the second column
now contains the pipe name, and the third column contains the mass flow rate.
The Output Control window allows you to specify the parameters, units, and
display order of the parameters that you want to see in the output. This
flexibility will help you work with Arrow in the way that is most meaningful to
you, reducing the possibility of errors.

28 Arrow 11 Quick Start Guide



► Lastly, double-click the column header for the “Vel. In” parameter in the
Output window in the Pipes table. This will open a window in which you can
change the units once again if you prefer (see Figure 2.17). These changes are
extended to the Output Control parameter data you have previously set.

Figure 2.17 The Change Units window is opened from the Output window
tables by double-clicking the column header

Step 8. View the Workspace Layers

Workspace Layers can display input and output data values superimposed over
the graphical model layout. They can also overlay additional graphical
modifications, animations, and customize the appearance of objects in the
model. The displayed data can be organized on one or more layers which can be
toggled on or off, allowing flexibility for viewing results in a graphical manner.

► Navigate to the Workspace window by clicking on the Workspace tab or
pressing CTRL+W. Select the Workspace Layers tab in the bottom-right of the
Quick Access Panel. The Workspace Layers panel contains two sections named
Layer Presets and Layers.

Within the Layers section, there are two layer groups named Advanced Layers
and Standard. We will integrate the model results with the graphical layout of
the pipe network by using a Standard layer. All models must have at least one
Standard layer, so by default there will be a "Layer 1" automatically created. It
will contain all objects in the model (pipes, junctions, annotations, etc);
however, objects can be hidden if desired, or the visibility of the entire layer
itself can be toggled on/off using the eye icon next to the layer. When additional
layers are created they will stack on top of each other, with the layers on top
taking precedence over others below. The combination of layers and toggling
visibility allows for a wide range of visual customization.

► Open the Layer Settings window for Layer 1 by double-clicking the layer.
The Layer Settings window is shown in Figure 2.18.

The Layer Settings window provides flexible options for customizing the
appearance of the model. The Pipes & Junctions group allows you to show or
hide junctions, and change display properties like color, size, and thickness. The
Label Control group allows you to display input and output parameters next to

29 Arrow 11 Quick Start Guide



objects on the Workspace. The Annotations group allows you to customize
annotations.

Figure 2.18 The Layer Settings window specifies content to be
superimposed on the Workspace

► Select the Pipe Parameters item under the Label Control group. The left
pane lists input and output parameters available for display, and the right pane
lists the parameters currently being displayed by the layer on the Workspace.

► In the left pane, expand the Pipe Parameters list. Add the Velocity Inlet
parameter to the right pane by either double- clicking the parameter or selecting
the parameter and clicking the arrow between the panes. The displayed unit
selection will be available in the dropdown. Select the meters/sec units for the
Velocity Inlet parameter.

► Select the Junction Parameters item under the Label Control Group.
Expand the Junction Parameters list and add the Pressure Static Inlet parameter
with units of barG. Close the Layer Settings using the button in the bottom-right.

► Add additional clarity by repositioning the labels and adding a legend. It is
common for the text on the Workspace Layers to overlap with objects when first
generated. Labels can be dragged to a new area or a smaller font can be selected
using the Font Decrease icon on the Workspace Toolbar or from within the
Global Layer Settings. Parameter units can be consolidated in a legend which
can be added via the Global Layer Settings. In the Layers Toolbar, click the
double gear icon to open the Global Layer Settings. Then, enable the checkbox
for Show Units in Legend. The result of these adjustments is shown in Figure
2.19.
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Figure 2.19 Results are superimposed on the model layout via Workspace
Layers

Step 9. View the Graph Results
► Change to the Graph Results window by clicking on the Graph Results tab or

choosing it from the Window menu. The Graph Results window offers versatile
graph generation and preparation.

Arrow’s Graph Guide, accessed by clicking on the “What Would You Like to
Do?” button located at the top-right of the Graph area, provides assistance by
guiding you through the creation of a “Quick and Simple” graph, or an
“Advanced” graph (Figure 2.20). You can create a graph by following the
prompts on the Graph Guide, by manually specifying the graphing parameters
on the Graph Control tab on the Quick Access Panel, or from the “Select Graph
Parameters” icon located in the top-left corner of the Graph Results toolbar. For
the remainder of this Quick Start Guide, the Graph Guide will be hidden, but
keep in mind that you can use it whenever you would like assistance in creating
a graph.

Figure 2.21 shows the Graph Results window with the Graph Control tab
enabled on the Quick Access Panel.
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Figure 2.20 The Graph Guide can be toggled on and off by clicking the
“What Would You Like to Do?” button on the Graph Results
window

Figure 2.21 The Graph Results window is where various system
parameters can be graphed

Arrow gives you the ability to create stacked graphs. These are graphs that are
displayed on top of each other with the same x-axis but with different
parameters on the y-axis. This feature helps show the output of multiple
parameters in the same location of your model simultaneously without creating
completely separate graphs.

► Click the Profile tab on the Parameters pane. In the Pipes selection list, click
the All button to select all the pipes.

► For the Length Units, keep the default units of meters.

► From the Parameters definition area, keep Pressure Static selected and
select units of barG.

► To add a stacked graph, click the Add button with the green “+” icon next to
Select Parameter, shown in Figure 2.22. A new row under the Parameters
definition area will appear.

► Choose Velocity in this new parameter row, and select units of meters/sec.
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► Click the Generate button to create the stacked pressure and velocity graphs,
shown in Figure 2.23. Note that the total static pressure loss across the orifice is
approximately 6.6 bar.

► To format the legend font size, right-click on a legend and use the slider bar to
decrease the font size to 12 for both graphs. Drag the static pressure graph
legend to the upper-right corner of the graph to improve visibility of the graphed
data.

► To format each axis font size, right-click on each axis title and use the slider
bar to decrease the size until the font size on each axis appears as you like.

Figure 2.22 The Graph Control tab on the Quick Access Panel allows you
to specify the graph parameters you want to graph in the
Parameters/Formatting area

The Formatting area on the Graph Control tab can be used to modify the graph
colors, fonts, and other elements. Options to copy the graph image or x-y data
are available on the Graph Results Toolbar or by right-clicking the graph. The
graph image or x-y data can be saved from the File menu.
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Figure 2.23 The Graph Results window showing a graph of the static
pressure and velocity along the entire length of the pipeline

Step 10. Modify the system

So far in this example, there has been no input for “CdA for Sonic Choking” on
the Orifice Properties window. This input is optional, but without a CdA input,
sonic choking cannot be checked at this location, and choking would not occur
at the orifice. Sonic choking can occur at a different location, as was seen at the
J3 Tank junction.

To see the effects of CdA, enter a CdA that is 20% higher than the sonic area,
and run the Arrow model again. The previous sonic area at J2 was 8.89 cm2, and
the new value should be 10.668 cm2 (i.e., 20% higher). How do the results
change? What happens if you set the optional orifice CdA to a value 20% lower
than the sonic area (7.112 cm2)?

Note: This is a situation where a user could create two new scenarios using the
Scenario Manager to examine several "what-if" situations, without disturbing the
basic model. See Chapter 3 for an example that illustrates how to use the
Scenario Manager.

When the orifice CdA is set to a value higher than the sonic area, it has no effect
on the model. However, setting the orifice CdA to a value lower than the sonic
area will result in sonic choking at that location.
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Here, a value 20% lower than the sonic area causes the flow rate to decrease
from 1.97 to 1.59 kg/sec, and the discharge pressure to decrease to 5.37 bar. For
this system, lowering the orifice CdA to a value 20% less than the sonic area
also causes the system to choke in two places rather than just one. This can be
seen on the Sonic Choking tab in the General Output window.

Conclusion

You have now used Arrow's Primary Windows to build and analyze a simple
model.
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C H A P T E R 3

Compressed Air System Analysis Example

This example demonstrates how to determine the range of outlet temperatures
for a compressed air system, given a range of numerous design assumptions.

Topics covered
� Entering heat transfer data for piping

� Modeling compressors with curve data

� Modeling heat of compression at compressors

� Modeling junction losses with a resistance curve

� Using scenarios

� Using the Global Pipe Edit feature

� Creating dual y-axis graphs

� Using the Isometric Pipe Drawing Mode

Required knowledge

This example assumes that the user has some familiarity with Arrow such as
placing junctions, connecting pipes, and entering pipe and junction properties.
Refer to the example in Chapter 2 for more information on these topics.

Model file

A completed version of the model file can be referenced from the Examples
folder as part of the Arrow installation:

C:\Users\[username]\Documents\Datacor\Arrow 11\Examples
� Metric - Compressed Air System.aro

36 Arrow 11 Quick Start Guide



Problem statement

In this example, four machine tools are supplied air for operations. The machine
tools are sensitive to temperature, but the manufacturer says they can
compensate for this if they know the extremes of the delivery temperature the
tools will see.

The air is taken from outside the building (P = 0 barG), and the air temperature
outside can vary from -18 to 45 deg. C depending on the season. The
temperature inside the building is 21 deg. C, and the inside ambient air velocity
is 1.5 km/hr which affects convective heat transfer on the pipes supplying the
compressed air to the machine tools.

The compressor used to drive the system has the following stagnation pressure
rise characteristics: 83 kPa at 0 kg/sec, 69 kPa at 0.25 kg/sec, and 41 kPa at 0.5
kg/sec. The compressor efficiency curve is not known, but the polytropic
constant is expected to be between 1.45 and 1.55.

The nozzles at the tools have a pressure drop of 55 kPa at 0.1 kg/sec. The
nozzles discharge to atmospheric pressure.

The pipes in the system are uninsulated steel. The pipe at the compressor inlet is
heavily insulated (adiabatic). All of the components in the system are at an
elevation of 0 meters.

Determine the temperature extremes of this system, so the machine tools
manufacturer can compensate for the tool's temperature sensitivity.

Step 1. Specify fluid properties
1. Open Analysis Setup from the Common Toolbar or the Analysis menu.

2. Under the Fluid Properties group, click the Fluid item to open the Fluid
panel. Select the Arrow Standard library and then select “Air” in the
“Fluids Available in Library” list.

3. Click “Add to Model” to select air for use in this model.

4. Use the default “Redlich-Kwong” for the equation of state and
“Generalized” for the enthalpy model.

5. Click OK to accept the changes and close Analysis Setup.

Step 2. Build the model

A. Place the pipes and junctions
This completes the first two groups of the Analysis Setup. The Pipes and
Junctions group remains undefined. To complete this group, begin by
assembling the model on the Workspace as shown in Figure 3.1.
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Figure 3.1 Layout of the pipe system for the Compressed Air System
Example

B. Enter the pipe data
With the objects in place, define the input data for the pipes and junctions.
Double-click each pipe object, and enter the following data in the Properties
window:

All of the pipes are Steel - ANSI, with standard roughness, and the following
data:

Pipe Length (meters) Nominal Size Type
P1 0.3 2 inch Schedule 40

P2 - P5 8 2 inch Schedule 40
P6 - P9 3 1 inch Schedule 40

1. Because the pipe at the compressor inlet (P1) is very well insulated for all
of the cases you will analyze, it can be considered adiabatic. Open the
Properties window for Pipe P1 and select the Heat Transfer tab. Ensure that
the Heat Transfer Model is set to “Adiabatic (Perfectly Insulated)”, then
click OK.

2. For the remaining uninsulated pipes (P2-P9), you will need to set the pipe
heat transfer properties on the Heat Transfer tab on the Pipe Properties
window.

Arrow has a feature that can be used to change the heat transfer properties
for multiple pipes at the same time. This feature is called Global Pipe Edit.

Open the Global Pipe Edit window from the Workspace Toolbar or the Edit
menu. Click “All” to select all of the pipes shown in the Pipe List. Then click on
the check box beside Pipe 1 to deselect it. Since Pipe 1 has different properties
than the other pipes (it is adiabatic), you should not include it in this global
change. The Global Pipe Edit window should appear as shown in Figure 3.2.
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Figure 3.2 Global Pipe Edit window showing the pipes selected to be
included in the global edit

Click the Select Pipe Data button. This will open a template Pipe Properties
window that will be used to enter the pipe parameters we wish to change on all
of the selected pipes.

On the Pipe Model tab, set the Pipe Material to Steel - ANSI. No other changes
are necessary on this tab.

Click on the Heat Transfer tab. Select “Convective Heat Transfer” for the Heat
Transfer Model, and enter 21 deg. C for the Ambient Temperature and 1.5 km/hr
for the Fluid Velocity with Air as the fluid. Also, ensure that the Gnielinski
correlation is selected under the Convection Coefficient column in the Fluid
Internal row, and that Forced (Churchill-Bernstein) is chosen in the External
row. The Pipe Properties window should appear as shown in Figure 3.3. Select
OK.
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Figure 3.3 The Heat Transfer tab is where you specify heat transfer
properties for the pipe

The Global Pipe Edit window will now display a list of all the parameters that
may be applied to the selected pipes. The parameters are categorized as they are
displayed on the tabs of the Pipe Properties window. For this example, you want
to select all of the parameters listed in the Heat Transfer category (see Figure
3.4). Since these items are the only things selected in the parameter list, they are
the only parameters that will be changed in the pipes.

Apply the changes to the selected pipes by clicking the Apply Selections button.
You will be notified that the changes were successfully applied with a message
in the bottom-left of the Global Pipe Edit window. If you wish to cancel all of
the changes you applied, click Cancel on the Global Pipe Edit window.
Otherwise, accept the changes by clicking OK.

Note: The Guide button in the Global Edit windows may be used as a reminder
of the required steps for the global edit process if needed.

The heat transfer data for Pipes P2-P9 have all been updated to reflect the new
values. Open the Properties window for one of the pipes to verify that the
changes were made.
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Figure 3.4 Global Pipe Edit window showing the parameters to be
applied to all pipes selected in the Pipe List

C. Enter the junction data

J1 Tank
1. Name = Atmosphere

2. Elevation = 0 meters

3. Pressure = 0 barG

4. Temperature = 45 deg. C

J2 Compressor
1. Elevation = 0 meters

2. Select Centrifugal Compressor and set the Compressor Model to Curve

3. Added Pressure = Stagnation

4. Compression Process Thermodynamics = Polytropic, 1.55

5. Select the Enter Curve Data button and enter the following mass flow and
pressure data into the Raw Data table in the Compressor Configuration
window that is shown in Figure 3.5

m' (kg/sec) dP (kPa)
0 83

0.25 69
0.5 41
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6. In the Curve Fitting section, configure the settings as follows: Polynomial
type, select the check box for Pressure Rise, and Curve Fit Order of 2 (see
Figure 3.5). Then, click the Generate Curve Fit Now button to generate the
Compressor Performance graph (see Figure 3.6). Select the OK button on
the Compressor Configuration window to accept the Compressor curve fit
and to close the window. Select the OK button to close the Compressor/Fan
Properties window.

Figure 3.5 The Compressor Configuration window is where performance
data is entered and fitted with a curve
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Figure 3.6 Compressor Configuration window Composite Graph tab
showing plots of curve fits generated from the Raw Data table

J3 - J6 Branches
1. Open the Branch Properties window and enter an elevation of 0 meters for

all of the Branch junctions.

J7 Valve (Tool #1)
1. Name = Tool #1

2. Elevation = 0 meters

3. Set the Loss Source to User Specified

4. Set the Loss Model to Resistance Curve

5. Check the optional Exit Valve box

6. Exit Pressure = 0 barG

7. Exit Temperature = 21 deg. C

8. Click the Enter Resistance Curve Data button. Set the Flow Parameter to
Mass flow in kg/sec and the Head/Pressure Parameter to Pressure in kPa.
Enter 0.1 kg/sec and 55 kPa in the proper columns of the Raw Data table,
then click the Fill As Quadratic button to generate the resistance curve data.
Then click the Generate Curve Fit Now button to generate the resistance
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curve. Click the OK button to accept the curve fit and to close the Valve
Loss Curve Fit window and Valve Properties window.

J8, J9, and J10 Valves (Tool #2, Tool #3, and Tool #4)
1. For the J8 Valve, open the Valve Properties window, and select J7 (Tool

#1) from the Copy Data From Jct list. This will open the Copy Data From
Junction window. Click the All button. This will mark all of the properties
for J8 to be set the same as the properties for J7. Since you want the J8 tool
to retain its unique name, click on the check box next to the Name
parameter to deselect it (see Figure 3.7). Click the OK button. J8 now has
all of the same properties as J7, with the exception of its name.

2. Enter the name as Tool #2.

3. Repeat this process for J9 and J10, entering names of Tool #3 and Tool #4,
respectively.

Figure 3.7 The Copy Data From Junction window allows you to copy
selected data from one junction to another

D. Check if the pipe and junction data is complete
Check the Model Status light in the bottom-right of the Quick Access Panel. A
green light at this point indicates a fully defined model. A red light indicates
undefined pipes or junctions in the model. If this happens, go back to the
incomplete pipes or junctions and enter the missing parameters. Alternatively,
open the List Undefined Objects window from the View menu to see the
undefined objects.
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Note: Optionally, you can create a layer named Valve Labels with the valves set
to visible within the Show/Hide Labels group in Layer Settings and the
parameters Junction Name and Temperature Static Inlet selected in Junction
Parameters.

Step 3. Create scenarios for the extreme temperature cases

For this problem, you are required to determine the temperature extremes at the
tools based on the range of system specifications. To do this, you will use the
Scenario Manager to examine the hot and cold extremes for the system.

The Scenario Manager is a powerful tool for managing variations of a model,
referred to as scenarios. The Scenario Manager allows you to:
� Create, name, and organize scenarios

� Select the scenario to appear in the Workspace (the current scenario)

� Delete, copy, and rename scenarios

� Duplicate scenarios and save them as separate models

� Review differences between scenarios using the Scenario Comparison Tool

� Propagate changes from a parent scenario to its children

Create two scenarios to model these cases. Access the Scenario Manager from
the Quick Access Panel, which is located on the right side of the Workspace
area, or from the Tools menu. A scenario tree displays all model scenarios.

Click the Create Child button on the Quick Access Panel, or from the right-click
menu on the Base Scenario (see Figure 3.8). Name the child “Hot Case”. A new
scenario will appear below the Base Scenario in the scenario tree, and it will be
automatically selected and loaded. Select the Base Scenario, create another
child, and call it “Cold Case” (see Figure 3.8).
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Figure 3.8 Create model variants and keep them organized using the
Scenario Manager on the Quick Access Panel

Step 4. Set up the Hot Case scenario

The Base Scenario contains all of the basic information for the model, such as
the pipe and junction layout, pipe lengths, system properties, etc.

Child scenarios inherit data from their ancestors. As long as the data has not
been modified in a child scenario, parameters in the child scenario will have the
same value as their parent. We will modify the system conditions to simulate the
case that will result in the hottest temperature at the tools.

Double-click the Hot Case scenario in the scenario tree of the Scenario Manager
on the Quick Access Panel. This loads the Hot Case scenario onto the
Workspace as the current scenario. The currently loaded scenario is displayed in
the scenario tree with a green circle and a white check mark (Figure 3.8).
Alternatively, you can use the Scenario Manager window from the Tools menu
to load the scenario.

In order to simulate the Hot Case, we must decide which combination of design
parameters will result in the highest tool temperatures. As a reminder from the
problem statement, there are two main variables: the outside air temperature that
enters the system and the polytropic constant of the compressor (related to the
unknown efficiency).

Check the following model information as indicated:

J1 Tank (Atmosphere)
The tools will see a higher temperature if the inlet air from outside is at the
highest end of the seasonal range which is 45 deg. C. Since we used this value
in the Base Scenario, it has propagated to this Hot Case child scenario.
Therefore, no changes are needed to the Tank in this scenario, but open the J1
Tank and verify that it has the correct value.
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J2 Compressor
The compressor will generate more heat if it is less efficient. This will
correspond to a higher polytropic constant from the range which is 1.55. Since
we used this value in the Base Scenario, it has propagated to this Hot Case child
scenario. Therefore, no changes are needed to the Compressor in this scenario,
but open the J2 Compressor and verify that it has the correct value.

Step 5. Run the Hot Case scenario

Select “Run Model” from the Common Toolbar or in the Analysis menu. The
Solution Progress window opens and begins iterating. This window displays the
Arrow Solver converging on the answer. After the Solver converges, view the
results by clicking Output at the bottom of the Solution Progress window.

The output for the Hot Case scenario is shown in Figure 3.9. The junction output
table shows the highest inlet static temperature at the tools for the Hot Case is
95.3 deg. C.

Figure 3.9 Output window for the Hot Case scenario

When compressors/fans are inclded in a model, Arrow gathers the related data
together in one convenient location in the Output window. This information can
be found on the Compressor/Fan Summary tab located in the General Output
section of the Output window, as shown at the top of Figure 3.9.

From Figure 3.9, the Compressor/Fan Summary shows that the compression
requirement is about 0.70 bar, and the mass flow is about 0.27 kg/sec.

The Compressor/Fan Summary can also be displayed in a Results Diagram, as
shown in Figure 3.10, by selecting the button next to “Show” in the Results
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Diagram column, double-clicking nywhere in the row, or right-clicking
anywhere in te row and selecting Results Diagram.

Figure 3.10 Compressor Results Diagram

The pipe heat transfer results from the Heat Transfer tab (see Figure 3.11) can
also be displayed in a Results Diagram, as shown in Figure 3.12, by selecting
the button next to “Show” in the Results Diagram column, double-clicking
anywhere in the row, or right-clicking anywhere in the row and selecting Results
Diagram.
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Figure 3.11 The Heat Transfer tab in the Output window shows detailed
heat transfer results for pipes

Figure 3.12 Pipe Heat Transfer Results Diagram

Step 6. Graph the Results

Arrow allows you to create dual y-axis graphs, which plot two parameters on
the same graph.

In this example, you will graph the static temperature and the static pressure
from the J1 Tank through the pipeline to Tool 4 (J10) on a dual y-axis graph to
help you understand how the temperature and pressure change as the air flows
through the pipeline.
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Note: You can repeat this process for the flow path from the J1 Tank to the
other tools, or you can graph the flow through each path on this same graph
using the Plot Multiple Paths Using Groups feature.

1. From the Graph Results window, in the Graph Control tab, choose the
Profile tab in the Parameters/Formatting area, specify Plot Single Path in
the Pipes definition area, then select pipes P1-P5 and P9. These pipes make
up the path from the J1 Tank junction to Tool 4.

2. Ensure that meters are selected for the Length Units.

You will need to decide what parameter you wish to plot on the primary y-axis
and which parameter you want to plot on the secondary y-axis. In this example,
we will plot static pressure on the primary y-axis and static temperature on the
secondary y-axis.
3. To do this, select Pressure Static in the Parameters definition area and

choose bar as the static pressure unit.
4. Add a parameter by clicking on the Add button next to Select Parameter in

the Parameters definition area.
5. Change this added parameter to Temperature Static and choose deg. C as

the unit.
6. To specify that the temperature will be plotted on the secondary y-axis, first

select this parameter by clicking on the box to the left of Temperature
Static, then click on the Make Secondary Y-Axis icon (this is the blue,
right arrow icon located at the top-right over the selected parameters).
Alternatively, you can double-click on the box to the left of Temperature
Static in the Parameters definition area. Note that Temperature Static
becomes indented under Pressure Static, and that the black arrow next to
Temperature Static turns to point towards the left. See Figure 3.13 to see
how these graphing parameters are defined.
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Figure 3.13 Parameter definition for a dual y-axes graph of static pressure
(primary y-axis) and static temperature (secondary y-axis) on
the Graph Control tab on the Quick Access Panel

Click the Generate button. You will see that the static pressure and temperature
increase after the air flows through the compressor, and then these parameters
gradually drop as the air flows through the pipes and to each tool. See Figure
3.14 for this graph.
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Figure 3.14 Pressure and temperature from the J1 Tank junction to Tool 4
(J10) plotted on a dual y-axis graph

Step 7. Set up the Cold Case scenario

Double-click the “Cold Case” scenario in the list in the Scenario Manager on the
Quick Access Panel. This will load the “Cold Case” scenario onto the
Workspace as the current scenario.

In order to simulate the Cold Case, we must decide which combination of design
parameters will result in the lowest tool temperatures. As a reminder from the
problem statement, there are two main variables: the outside air temperature that
enters the system and the polytropic constant of the compressor (related to the
unknown efficiency).

Modify the following model information as indicated:

J1 Tank (Atmosphere)
The tools will see a lower temperature if the inlet air from outside is at the
coldest end of the seasonal range. Set the temperature to the lowest value of -18
deg. C.

J2 Compressor
The compressor will generate less heat if it is more efficient. This will
correspond to a lower polytropic constant from the range. Set the compressor
polytropic constant to 1.45.
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Step 8. Run the Cold Case scenario

Select “Run Model” from the Common Toolbar or in the Analysis menu. When
the solution has converged, view the results by clicking on the Output button at
the bottom of the Solution Progress window.

The output for the Cold Case scenario is shown in Figure 3.15. The junction
output table shows the lowest inlet static temperature at the tools for the Cold
Case is 20.3 deg. C.

Figure 3.15 Output window for the Cold Case scenario

Analysis summary

The compressed air system for some machine tools was modeled with
convective heat transfer on the pipes and heat of compression modeled for the
compressor. Two design cases were set up by selecting a combination of design
parameters that modeled temperature extremes and was implemented by using
the Scenario Manager. The temperature extremes of 20.3 deg. C and 95.3 deg. C
can now be sent to the tool manufacturer who will use it to compensate for the
temperature sensitivity of the tools.

Isometric Pipe Drawing Mode

Arrow uses a 2D grid by default for objects on the Workspace, as was the case
with this example.
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Figure 3.16 shows the compressed air system with the 2D grid displayed (select
Show Grid from the Arrange menu).

Figure 3.16 Compressed air system with the 2D grid shown

At times it may be convenient to demonstrate the three-dimensional nature of a
system. For example, you may be building a model based on isometric reference
drawings. Arrow includes an Isometric Pipe Drawing Mode for these cases. The
isometric grid has three grid lines that are offset by 60°, representing the x, y,
and z axes. Figure 3.17 shows the compressed air system built on an isometric
grid.

Figure 3.17 Compressed air system with the isometric grid shown

You can enable the isometric grid by going to the Arrange menu from the
Workspace. Under Pipe Drawing Mode, there are three options: 2D Freeform
(default), 2D Orthogonal, and Isometric.
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► Experiment with creating the compressed air system on an isometric grid to
see how to use this feature.
1. Go to the File menu and select New.

2. From the Arrange menu, choose Show Grid.

3. From the Arrange menu again, go to Pipe Drawing Mode and select
Isometric.

4. Place junctions J1-J7 on the Workspace in the positions shown in Figure
3.17.

5. You will notice that placing junctions onto the Workspace follows the
usual rules; however, the visual appearance of the icons can be more
complex than on a 2D grid. Due to the increased number of axes, the
preferred icon and rotation can be selected to obtain visual consistency.
Right-click on J7 and select Customize Icon. Select the icon shown in
Figure 3.18.

Figure 3.18 Right click on the junction to open the Customize Icon
window and select the preferred settings

6. Select J7 and duplicate the junction three times to create junctions J8-J10
using any of the following methods: CTRL+D keyboard shortcut, icon on
the Workspace Toolbar, Edit menu, or right-click context menu.
Duplicating the junction which will retain the preferred icon.

7. Draw Pipe P1 as shown in Figure 3.19.

8. Draw Pipe P2 from J2 to J3. A red-dashed preview line will show how the
pipe will be drawn on the isometric grid. As you are drawing a pipe, you
can change the preview line by clicking any arrow key on your keyboard or
scrolling the scroll wheel on your mouse. Figure 3.19 shows Pipe P2 being
drawn with the preview line.
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Figure 3.19 A preview line shows when drawing or adjusting pipes in the
Isometric Drawing Mode

Note: You can hold the ALT key while adjusting a pipe by the endpoint to add
an additional segment. This can be used with the arrow key or mouse scroll
wheel to change between different preview line options.

9. Draw Pipes P3-P9 as shown in Figure 3.17.

10. The grid can be shown or turned off in the Arrange menu.

You now know the basics of using the Isometric Pipe Drawing Mode.
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C H A P T E R 4

Natural Gas Burner System Example

This example demonstrates how to size a heat exchanger to deliver natural gas at
a minimum required temperature.

Topics covered
� Sizing a heat exchanger for a particular system

� Entering a loss curve for a heat exchanger

� Specifying heat transfer data for pipes

� Using flow control valves

Required knowledge

This example assumes that the user has some familiarity with Arrow such as
placing junctions, connecting pipes, and entering pipe and junction properties.
Refer to the example in Chapter 2 for more information on these topics.

Model file

A completed version of the model file can be referenced from the Examples
folder as part of the Arrow installation:

C:\Users\[username]\Documents\Datacor\Arrow 11\Examples
� Metric - Natural Gas Burner.aro

Problem statement

An underground storage reservoir containing natural gas made up mostly of
methane supplies gas to five burners. The gas source is at 34.5 barG, and 10
deg. C. The gas is supplied to each of the burners at 6.9 barG. To assure that the
flow to each of the burners is equal, each burner has a control valve that controls
the flow to 2.25 kg/sec.

The pipes in the system are uninsulated STD (schedule 40) steel pipes, with
standard roughness. The ambient temperature surrounding the pipes is 24 deg. C,
with an air velocity of 25 km/hr.
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In order to operate at the best efficiency, the gas should be delivered to the
burners at a minimum stagnation temperature of 38 deg. C. To achieve this, the
gas flows through a heat exchanger which has a 70 kPa pressure drop at 11
kg/sec.

How much heat must be added by the heat exchanger to ensure that all of the
burners will receive gas at the specified minimum temperature? Elevation
changes can be neglected.

Step 1. Specify fluid properties
1. Open Analysis Setup from the Common Toolbar or the Analysis menu.

2. Under the Fluid Properties group, click the Fluid item to open the Fluid
panel, if not already open. Select the Arrow Standard library and then select
“Methane” in the “Fluids Available in Library” list.

3. Click “Add to Model” to select methane for use in this model.

4. Use the default “Redlich-Kwong” for the equation of state and
“Generalized” for the enthalpy model.

5. Click OK to save and close Analysis Setup.

Step 2. Build the model

A. Place the pipes and junctions
The Modules and Fluid Properties groups in Analysis Setup are now complete.
The Pipes and Junctions group remains undefined. To complete this group,
begin by assembling the model on the Workspace as shown in Figure 4.1.

Figure 4.1 Layout of the pipe system for the Natural Gas Burner System
Example
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B. Enter the pipe data
With the objects in place, define the input data for the pipes and junctions.
Double-click each pipe and enter the following data in the Properties window
(or use the Global Pipe Edit window, as discussed in Chapter 3).

All of the pipes are Steel - ANSI, STD (schedule 40), with the Standard friction
model and the following data:

Pipe Length (meters) Nominal Size
P1 30 4 inch

P2 - P6 6 4 inch
P7 - P16 1.5 3 inch

Enter the following data on the Heat Transfer tab for each pipe, as shown for
Pipe P1 in Figure 4.2:
1. Heat Transfer Model = Convective Heat Transfer

2. Ambient Temperature = 24 deg. C

3. Fluid Velocity = 25 km/hr

4. Fluid = Air

Figure 4.2 Pipe Heat Transfer properties to be applied to all pipes

C. Enter the junction data

J1 Tank (Supply Reservoir)
1. Elevation = 0 meters

2. Pressure = 34.5 barG

3. Temperature = 10 deg. C
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J2 Heat Exchanger
1. Elevation = 0 meters

2. Enter Loss Model Data
a. Select the Loss Model as “Resistance Curve”, and then click the

“Enter Curve Data” button
b. Select “Mass” as the Flow Parameter

c. Enter 11 kg/sec and 70 kPa in the Raw Data table

d. Click the “Fill As Quadratic” button to generate data for the loss curve

e. Select “Generate Curve Fit Now” to create a quadratic curve fit

f. Click OK to close the Heat Exchanger Loss Curve Fit window

To solve this problem, you will have to make an initial guess for how much heat
to add to the heat exchanger, examine the results, and adjust the heat added until
you achieve the desired minimum temperature at the burners. To do this, select
the Thermal Data tab on the Heat Exchanger Properties window, and select the
Thermal Model as "Specified Heat Rate In Constant". Then enter a value for
Heat Flow Into System. For the first guess, use 500 kW.

J8 - J12 Flow Control Valves
1. Elevation = 0 meters

2. Valve Type is Flow Control (FCV)

3. Control Setpoint, Mass Flow Rate = 2.25 kg/sec

J13 - J17 Tanks (Burners)
1. Elevation = 0 meters

2. Pressure = 6.9 barG (690 kPa(g))

3. Temperature = 260 deg. C

J3 - J7 Branches

1. Elevation = 0 meters

D. Check if the pipe and junction data is complete
Check the Model Status light in the bottom-right of the Quick Access Panel. A
green light at this point indicates a fully defined model. A red light indicates
undefined pipes or junctions in the model. If this happens, go back to the
incomplete pipes or junctions and enter the missing parameters. Alternatively,
open the List Undefined Objects window from the View menu to see the
undefined objects.
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Step 3. Run the model

Select “Run Model” from the Common Toolbar or in the Analysis menu. The
Solution Progress window opens and begins iterating. This window displays
the Arrow Solver converging on the answer. After the Solver converges, view
the results by clicking Output at the bottom of the Solution Progress window.

Step 4. Examine the results

Examination of the stagnation temperature at the outlets of the pipes discharging
to the burners shows that the lowest temperature is
16.93 deg. C (see Pipe P16 in Figure 4.3). This is well below the required
minimum temperature of 38 deg. C. The heat added to the heat exchanger must
be increased, and the model must be run again to determine the outlet
temperature at the new value.

Step 5. Manually iterate the heat rate

By trial and error, you will find that you need to add 1052 kW to the heat
exchanger to achieve a minimum stagnation temperature of 38 deg. C.

Analysis summary

Using Arrow, you were able to determine the amount of heat required by the
heat exchanger to supply natural gas to the burners at the minimum required
temperature.

The goal seeking capabilities in the optional Arrow GSC Add-on Module would
allow this problem to be solved directly without manual iteration. The variable
would be specified as the heat exchanger heat rate, and the goal would be the
minimum discharge pipe exit temperature.

More discussion on the GSC Add-on Module is given in Chapter 5.
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Figure 4.3 Output for the Natural Gas Burner System Example
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C H A P T E R 5

Arrow Add-on Modules Examples

This chapter covers two examples. The first example demonstrates how to use
the Goal Seek & Control (GSC) Add-on Module, and the second demonstrates
how to use the Extended Time Simulation (XTS) Add-on Module.

A separate Quick Start Guide is available and covers the Automated Network
Sizing (ANS) Add-on Module.

The user can only perform these examples if access to the relevant modules is
available.

Topics covered
� GSC - Using the Goal Seek and Control Manager

� GSC - Defining Variables and Goals

� GSC - Using Group Max/Min Goals

� GSC - Linking Variables

� XTS - Specifying the Transient Control group

� XTS - Defining system transients

� XTS - Understanding Transient Output

Required knowledge

This example assumes that the user has some familiarity with Arrow such as
placing junctions, connecting pipes, and entering pipe and junction properties.
Refer to the example in Chapter 2 for more information on these topics.

To model the heat transfer in these examples, the user may need to refer to
Chapter 4 for more detailed explanations.

Model files

For your reference, see the completed model files for these examples installed in
the Examples folder as part of the Arrow installation:

C:\Users\username\Documents\Datacor\Arrow 11\Examples
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� Metric - Process Steam System - GSC.aro

� Metric - Air Receiver Tank - XTS.aro

GSC Problem statement

A process steam supply system has two boilers at 20.7 barG and 430 deg. C.

All of the pipes in the system have 5 cm of insulation with a thermal
conductivity of 0.03 W/m-K. The ambient temperature is 24 deg. C with an
average air velocity of 11 km/hr. The pipes are all Steel - ANSI, schedule 40.
All of the elbows in the system are Smooth, with an r/D of 1.5.

Assume “Redlich-Kwong” for the equation of state model, and “Generalized”
for the enthalpy model.

The system has six users with variable peak flow demands.
� User 1: 18,000 kg/hr

� User 2: 23,000 kg/hr

� User 3: 25,000 kg/hr

� User 4: 25,000 kg/hr

� User 5: 18,000 kg/hr

� User 6: 27,000 kg/hr

For the specified design flows, the process steam system must meet a minimum
delivery pressure of 7 barG at each discharge.

GSC Step 1. Specify fluid properties
1. In the Analysis Setup window on the Fluid panel, select the Arrow

Standard library, and then select “Steam” in the Fluids Available in Library
list

2. Click “Add to Model” to select steam for use in this model

3. Retain the default selection of the "Redlich-Kwong" equation of state and
"generalized" enthalpy model.

4. Click the OK button

GSC Step 2. Build the model

A. Place the pipes and junctions
The Fluid Properties group within Analysis Setup is now complete. The
Modules group will be updated in a later step but currently appears as complete.
To complete the remaining group, begin assembling the model on the
Workspace as shown in Figure 5.1.
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Figure 5.1 Layout of the pipe system for the Process Steam System
Example

B. Enter the pipe data
With the objects in place, define the input data for the pipes and junctions.
Double-click each pipe and enter the following data in the Properties window
(or use the Global Pipe Edit window, as discussed in Chapter 3):

Pipe Nominal Size Type Length (meters)
P1 12 inch schedule 40 30
P2 12 inch schedule 40 46
P10 12 inch schedule 40 23

P101 8 inch schedule 40 122
P102 8 inch schedule 40 229
P103 8 inch schedule 40 229
P104 8 inch schedule 40 76
P105 6 inch schedule 40 30
P106 6 inch schedule 40 15
P107 6 inch schedule 40 23
P201 8 inch schedule 40 76
P202 8 inch schedule 40 152
P203 8 inch schedule 40 152
P204 8 inch schedule 40 152
P205 6 inch schedule 40 15
P206 6 inch schedule 40 23
P207 6 inch schedule 40 15

Enter the following data on the Heat Transfer tab for each pipe:
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1. Heat Transfer Model = Convective Heat Transfer

2. Ambient Temperature = 24 deg. C

3. Fluid Velocity = 11 km/hr

4. Fluid = Air

5. Number of Insulation Layers = 1 External

6. Insulation #1 Conductivity = 0.03 W/m-K, Thickness = 5 cm

C. Enter the junction data

J1 and J2 Tanks
1. Elevation = 0 meters

2. Pressure = 20.7 barG

3. Temperature = 430 deg. C

J106 - J108 and J206 - J208 Assigned Flows
1. Elevation = 0 meters

2. Flow Rate = see Table below, and make sure the units are per hour and not
per second

Junction Flow Rate (kg/hr) Name
J106 18,000 User 1
J107 23,000 User 2
J108 25,000 User 3
J206 25,000 User 4
J207 18,000 User 5
J208 27,000 User 6

J102, J105, J202, and J205 Bends
1. Elevation = 0 meters

2. Type = Smooth Bend

3. Angle = 90 deg.

4. r/D = 1.5

Note: The arrangement of the pipes on the Detailed tee junctions is important.
Be certain that the inlet, outlet, and branch pipes are assigned appropriately.

J101, J103, J104, J201, J203, and J204 Tees
1. Elevation = 0 meters

2. Loss Model = Simple

3. Optional tab: Initial Pressure = 7 barG
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Note: Sometimes adding initial guesses to pipes or junctions can help difficult
solutions converge.

D. Check if the pipe and junction data is complete
Check the Model Status light in the bottom-right of the Quick Access Panel. A
green light at this point indicates a fully defined model. A red light indicates
undefined pipes or junctions in the model. If this happens, go back to the
incomplete pipes or junctions and enter the missing parameters. Alternatively,
open the List Undefined Objects window from the View menu to see the
undefined objects.

GSC Step 3. Create a scenario for the GSC Case

Create a new scenario from the Base Scenario for the GSC Case by either right-
clicking on the Base Scenario or using the Create Child button in the Scenario
Manager.

GSC Step 4. Activate the GSC Module

Open the Analysis Setup window and go the Modules panel under the Modules
group. Activate the GSC module by selecting Activate GSC as is shown in
Figure 5.2.

Though the module is activated, you have the option to use or ignore it. This is
helpful if you want to check the impact of changes in your system configuration
or in troubleshooting the model without solving for the variables. For the
module’s features to be used in the simulation calculations, set the GSC module
to Use under the Activate GSC checkbox (Figure 5.2). The Use and Ignore
options can also be toggled from the Goal Seek & Control item in the Analysis
menu.

Figure 5.2 Activating the GSC module and setting it to be used in Arrow
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GSC Step 5. Goal Seek and Control group

When the GSC module is activated, the Goal Seek and Control group appears in
the Analysis Setup window with the Variables, Goals, and Numerical Controls
panels.

The Goal Seek and Control settings are specified by entering data for variables
and goals in the Goal Seek and Control group panels. Go to the Variables panel
as shown in Figure 5.3 below.

GSC Step 6. Add the variables

In the GSC module, variables are the parameters that Arrow will modify in order
to achieve the specified goals. To obtain a unique answer, there should be one
variable applied for each goal. You may define as many variables and goals as
you wish.

The Variables panel allows users to create and modify the system variables.
Additionally, you can elect to apply certain variables while omitting others using
the check box in the Apply column.

Figure 5.3 The Goal Seek and Control group is used to define GSC
Variables and Goals

For this example, we want to find the supply pressures that will give us a
specific minimum discharge pressure. Select the “New Variable” button, and
input the following variable specifications:
1. Apply = checkbox enabled

2. Object Type = Junction

3. Junction Type = Tank
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4. Object Number and Name = J1 (Boiler 1)

5. Variable Parameter = Pressure

6. Link To = (None)

7. Lower and Upper Bounds = leave blank

The Apply column allows users to specify which of the variables that have been
defined will be used. This allows the flexibility of creating multiple variable
cases, while only applying selected variables for any given run.

The Link To column allows users to apply the same variable to multiple objects.
This allows users to force parameters for several objects to be varied identically.

Upper and lower bounds provide limits during the goal search. This can help
convergence when a logical extreme is known, but can also hurt convergence if
an unrealistic bound is entered and artificially restricts the solution.

Linking variables
This process steam system has two boilers to supply steam to the users. We have
defined a variable for the first boiler, but we have not yet accounted for the
second boiler.

For this example, the discharge pressures will be defined as a single Group
Max/Min goal. However, if we define the second boiler as another independent
variable, this would create only one goal for two variables.

To solve this issue, we will use variable linking. Variable linking allows you to
tie multiple variables together, forcing them to be the same. To accomplish this,
we will add a constraint to the problem that both of the boiler supply pressures
must be the same.

Select the “New Variable” button to add the variable for the second boiler. To
implement variable linking, specify J1 (Boiler 1) in the Link To column of the
J2 (Boiler 2) variable. Enter the data as shown below:
1. Apply = checkbox enabled

2. Object Type = Junction

3. Junction Type = Tank

4. Object Number and Name = J2 (Boiler 2)

5. Variable Parameter = Pressure

6. Link To = J1 (Boiler 1)

7. Lower and Upper Bounds = leave blank

After entering the data, the Variables panel should appear as shown in Figure
5.4. Note the variables panel will appear undefined until at least one goal is
applied.
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Figure 5.4 GSC Variables are parameters that are changed by Arrow to
achieve the defined goals

GSC Step 7. Add a goal

Goals are the parameters you want to determine. The goals are achieved as
Arrow modifies the variables. To obtain a unique answer, there should be one
goal applied for each variable. You may define as many variables and goals as
you wish.

Select the Goals panel in the Goal Seek and Control group. The Goals panel
allows users to create and modify the system goals. The goal type, object type,
and the goal parameter are selected. A criterion for determining if the goal has
been met is then specified, along with a value and units for the goal parameter.
The user then selects the object to which the goal applies and, if applicable, the
location on the object at which the goal applies (e.g., the inlet or outlet of a pipe
object).

For this example, we will be using a Group Max/Min goal. This type of goal
allows a single goal to be applied to a group of objects. Arrow applies a Group
Max/Min goal by ensuring the final goal value is either greater than or equal to
(Min) or less than or equal to (Max) the specified value.

For our example, a Group Max/Min goal will be applied to ensure the minimum
discharge pressure at all of the assigned flow junctions is at least 7 barG.

Define a group
In order to use a Group goal, the objects that the goal applies to must be added
to a Group.

To create a group, select the Groups > Create option from the Edit menu. When
prompted, give the new group a name, such as “Users”, and select OK.
Alternatively, you can select the Assigned Flow junctions on the Workspace
using CTRL+Click before creating the groups and they will be pre-selected
when the group is created.

After naming the new group, the Group Manager will be displayed. Select the
new group name from the list, and then select all of the assigned flow junctions
from the junction list, as shown in Figure 5.5. After choosing the assigned flow
junctions, select the OK button on the Group Manager window.
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Figure 5.5 Groups are created using the Group Manager

Add a Group Max/Min goal
Now that the group has been defined, reopen the Analysis Setup window, and
select the Goals panel. Add a new Goal by clicking the New Goal button, and
entering the following goal specifications:
1. Apply = Checkbox enabled

2. Goal Type = Group

3. Object Type = Group Max/Min

4. Goal Parameter = Pressure Stagnation

5. Criteria = >=

6. Goal Value = 7

7. Goal Units = barG

8. Object ID = Users

9. Object Location = NA

After entering the data, the Goals tab should appear as shown in Figure 5.6.

As variables and goals are added to a model, Arrow will display symbols beside
the pipes and junctions that have variables or goals applied to them. The default
is a “V” for variables, and a “G” for goals. This is illustrated in Figure 5.7.

The goal symbol is not displayed next to objects that are part of a group goal, so
you will see only the “V” displayed on the Workspace for this example.
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Figure 5.6 GSC Goals are the parameter values set by the user that
Arrow adjusts the variables to achieve

GSC Step 8. Run the model

Select “Run Model” from the Common Toolbar or in the Analysis menu. The
Solution Progress window opens and begins iterating. This window displays
the Arrow Solver converging on the answer. After the Solver converges, view
the results by clicking Output at the bottom of the Solution Progress window.

When using the GSC module, there is a new area displayed in Solution Progress
that shows the specific progress of the GSC module. As it makes progress, the
Best (Lowest) value will decrease towards zero. The field in the far right
displays how many complete hydraulic solutions have been run.

After completion click the Output button at the bottom of the Solution Progress
window.

Figure 5.7 Arrow displays symbols next to objects on the Workspace
that have goals or variables defined (unless it is a group goal)

GSC Step 9. Examine the results

The results of the GSC analysis are shown in the General Output section.
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The GSC Variables tab shows the final values for the variable parameters, as
shown in Figure 5.8. The GSC Goals tab shows the values achieved for the
goals, as shown in Figure 5.9.

GSC analysis summary

The GSC module analysis determined the supply pressure required to deliver a
minimum pressure of 7 barG at all of the users is 20.02 barG at the boilers. Note
that, because the variable for the J2 Boiler pressure was linked to the J1 Boiler
variable, the final variable results for both are identical.

Figure 5.8 The final GSC Variable values are shown on the GSC
Variables tab in the General Output section

Figure 5.9 The final GSC Goal values are shown on the GSC Goals tab in
the General Output section

XTS Problem statement

An initially unpressurized tank is being charged with compressed air for use in a
compressed air system. The compressed air tank needs to be charged to a
pressure of 8.5 barG.

An actively cooled positive displacement compressor rated for 170 sm3/h is used
in the system with an aftercooler which is sized to cool the air to 30 deg. C. The
cooler has a pressure drop of 20 kPa at 170 sm3/h. There is an isolation valve at
the air receiver tank inlet to control flow out of the tank during normal
operations with a Cv of 50 and Xt of 0.7.

Atmospheric air is assumed to be dry, with an ambient temperature of 21 deg. C.
Determine the time it will take to charge the air receiver tank for this process.
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XTS Step 1. Activate the XTS Module

Start a new model file and open the analysis setup window. Go to the modules
panel under the Modules group and activate the XTS module by selecting
“Activate XTS” as is shown in Figure 5.10.

Though the module is activated, you have the option to set the analysis to Steady
Only or Transient. This is helpful to check the steady state results for the model
without running the transient simulation. To run the Transient analysis, set the
XTS module to Transient under the Activate XTS checkbox (Figure 5.10). The
Steady Only and Transient options can also be toggled from the Time
Simulation item in the Analysis menu. The selection of Steady Only and
Transient is scenario specific. The activation of the XTS module is model wide
and should remain selected unless it is desired to remove XTS data from the
entire model.

When the XTS module is activated a new group will appear in Analysis Setup
titled Transient Control.

Figure 5.10 Activating the XTS module and setting the simulation type to
Transient

XTS Step 2. Define the simulation duration

XTS module transient simulations are controlled through the Simulation
Duration panel. You can access the Simulation Duration panel by selecting
Transient Control from the Analysis menu, navigating to the Simulation
Duration item in Analysis Setup, or by clicking the Simulation Duration shortcut
on the Common Toolbar. When the time simulation mode is set to Steady Only,
Arrow will ignore the input in the Simulation Duration panel. When Arrow is set
to perform a transient analysis, the Transient Control group becomes a required
item before the model can run.
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Use the Simulation Duration panel to specify transient start and stop times, set
time steps, and specify the number of output points that are saved to the output
file (allows XTS to do transient calculations with a small time step while
limiting the size of the data stored in the output file).

► Set the Start Time to 0 seconds and the Stop Time as 375 seconds, with a
time step of 1 second. The output will be saved to the output file for every time
step. The Simulation Duration panel should appear as shown in Figure 5.11.

Figure 5.11 The Simulation Duration panel is used to control transient
simulations

XTS Step 3. Specify fluid properties
1. In the Analysis Setup window on the Fluid panel, select the Arrow

Standard library, and then select “Air” in the Fluids Available in Library
list

2. Click “Add to Model” to select Air for use in this model

3. Retain the default selection of the "Redlich-Kwong" equation of state and
"generalized" enthalpy model.

4. Click the OK button

XTS Step 4. Build the model

A. Place the pipes and junctions
This completes the first two groups of the Analysis Setup. The Pipes and
Junctions group remains undefined. To complete this group, begin by
assembling the model on the Workspace as shown in Figure 5.12.
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Figure 5.12 Workspace for the Air Receiver Tank Example

B. Enter the pipe data
With the objects in place, define the input data for the pipes and junctions.
Double-click each pipe and enter the following data in the Properties window.

All of the pipes are Steel - ANSI, STD (Schedule 40).

Pipe Length (meters) Nominal Size
P1 6 3 inch

P2 - P4 3 3 inch

The Arrow XTS module assumes adiabatic behavior for all pipes, so no heat
transfer information is required for the pipes.

C. Enter the junction data

J1 Assigned Pressure
1. Elevation = 0 meters

2. Fluid = Air

3. Stagnation Pressure = 0 barG

4. Stagnation Temperature = 21 deg. C

J2 Compressor
1. Elevation = 0 meters

2. Compressor Model = Positive Displacement Compressor

3. Compression Process Thermodynamics = Polytropic

4. Polytropic Constant = 1.2
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5. Compressor Sizing Parameter = Mass Flow Rate

6. Fixed Flow Rate = 170 sm3/h

Note: The polytropic constant entered for the compressor is intended to
represent an active cooling element in the compressor.

J3 Heat Exchanger
1. Elevation = 0 meters

2. Enter Loss Model Data as follows:
a. Select the Loss Model as "Resistance Curve", and then click the

"Enter Curve Data" button
b. Select the "Flow Parameter" as "Mass" with units of "sm3/h"

c. Enter 170 sm3/h and 20 kPa in the Raw Data table

d. Click the "Fill As Quadratic" button to create data for a quadratic loss
curve

e. Select "Generate Curve Fit Now" to create a quadratic curve fit, then
click OK to close the Heat Exchanger Loss Curve Fit window

3. Enter Thermal Data as follows:
a. Thermal Model = Controlled Downstream Temperature

b. Controlled Outlet Temperature = 30 deg. C

Note: The controlled downstream temperature is used to simplify the inputs for
this example. For a more realistic analysis one of the cross-flow models could be
used.

J4 Valve
1. Elevation = 0 meters

2. Loss Source = User Specified

3. Loss Model = Cv

4. Cv = 50

5. Xt = 0.7

J5 Tank
The tank junction in the Arrow XTS module can be modeled as finite in order to
calculate the changes in pressure, temperature, and mass in the tank over time.
Define the air receiver tank using the Finite Tank Model as follows (Figure
5.13):
1. Elevation = 0 meters

2. Tank Model = Finite

3. Initial Conditions:
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a. Pressure = 0 barG

b. Temperature = 21 deg. C

4. Finite Tank Parameters:
a. Fixed Volume = 1900 liters

b. Thermodynamic Process = Isothermal

Figure 5.13 Properties window for the Tank junction defined as a Finite
Tank

XTS Step 5. Set Up the Compressor Transient

In the XTS module, you can define transients for junctions. These transients
include events such as valves opening and closing and compressors starting and
shutting down. Transients for junctions are defined as either time-based or
event-based transients. A time-based transient starts at a specified absolute time.
Event based transients initiate when a defined criteria, such as a specified
pressure in a particular pipe is reached. There are three types of event transients
for junctions: single event, dual event cyclic, and dual event sequential. Single
event transients are events that occur only once in a simulation. Dual cyclic
events are two transient events that repeat one after the other as many times as
the event trigger occurs during a simulation (such as a valve closing then
reopening). Dual sequential events are two transient events which occur one
after the other, without repeating.
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For this example, set a single event-based transient on the compressor so the
compressor will shut off over 30 seconds when the pressure at the tank inlet
reaches 8.5 barG.

► Open the Compressor Properties window for the J2 Compressor and navigate
to the Transient tab. Under Initiation of Transient, select Single Event and enter
the Transient data as shown below in Figure 5.14.

Figure 5.14 Compressor junction Transient tab with an event-based flow
transient defined

XTS Step 6. Run the model

After defining all of the pipe and junction transient data and transient control
items, the transient model can run. Click Run Model from the Common Toolbar
or Analysis menu.

When using the XTS module, the Solution Progress window displays the
progress through the transient analysis. This information is displayed below the
solution tolerance data.

After the run finishes, view the results by clicking the Output button.

XTS Step 7. Examine Transient Results

The Arrow XTS module displays transient output in a number of places in the
Output window, as shown in Figure 5.15.
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Figure 5.15 Transient output is displayed in the Output window

Each of the summary tables in the General Output section has a companion
transient summary tab which displays the summary data at each time step in the
transient run. The transient summary data for each junction may be expanded or
collapsed by clicking the + or – sign beside the junction data list. Figure 5.16
shows the Tank Transient summary tab, with all of the data sets collapsed.
Figure 5.17 shows the Tank Transient summary tab, with the data for the J5
Tank expanded.

Figure 5.16 Transient Summary tabs are displayed in the General Output
section
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Figure 5.17 Transient Summary data can be expanded to show the
junction data for every Time Step

The Event Message tabs in the General Output section (Figure 5.18) can be used
to see when events are triggered during the transient. For this example, the
Event Messages By Jct tab shows that the flow transient at the compressor was
triggered at 333 seconds into the transient, meaning it took 333 seconds to
pressurize the tank to the required pressure.

Figure 5.18 Event Messages By Jcn tab in the General section of the
Output window

The Quick Graph feature can be used to conveniently plot transient data for
rapid examination in any of the transient Output sections. To use the Quick
Graph feature, place the mouse cursor over one of the cells of data in the column
you wish to examine. Then, right-click with the mouse, and select Quick Graph
from the list. Figure 5.19 illustrates how to generate a Quick Graph in the
General Output section for the J5 Tank Pressure vs. Time. The graph illustrates
how the pressure in the tank rises over time and steadies out at about 9.9 bar
once the compressor fully shuts off (Figure 5.20). The Graph Results window
may also be used to create a full range of graphs related to the XTS module
transient output.
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Figure 5.19 Use Quick Graph to easily plot J5 Tank pressure

Figure 5.20 Quick Graph Plot of J5 Tank pressure

Similar to the summary transient data, the transient tabs in the Pipe and
Junctions sections of the Output window (shown in Figure 5.15) are used to
display the transient data for each pipe and junction at every time step. This
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transient data can be expanded or collapsed in the same manner as in the
General Output transient summaries.

Figure 5.21 shows the output data for the pipes and junctions, found on the
Pipes and All Junctions tabs, at the initial time step, Time = 0 seconds. The
output for all of the pipes and junctions can be displayed at any time step by
using the slider bar located at the bottom of the Output window. Figure 5.22
shows the pipe and junction data at Time = 60 seconds.

Figure 5.21 Pipe and Junction transient data at Time = 0 seconds

Figure 5.22 Pipe and Junction transient data at Time = 60 seconds
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C H A P T E R 6

Other Arrow Capabilities

This Quick Start Guide necessarily omitted or had brief coverage of a number of
important Arrow capabilities. This chapter briefly describes some of the
important capabilities not covered.

You can find a number of other example model discussions on the
documentation help website. To view additional examples, open the Help menu
and choose Show Examples or go to docs.aft.com, select the Arrow Help Site,
expand the Examples section in the sidebar, then select Walk-Through
Examples.

Microsoft Excel™ data integration

Arrow includes Excel importing and exporting. An Excel spreadsheet can be
used to vary selected input parameters in multiple scenarios. Selected output can
also be exported to specified Excel sheets and cells.

Integration with other software and data standards

Arrow includes a number of importing and exporting capabilities. Piping layouts
and dimensional data can be imported from GIS Shapefiles (*.SHP) to build a
model. Additionally, CAESAR II Neutral Files (*.CII) can be imported into
Arrow and EPANET Files (*.INP) can be both imported and exported.

Piping Component Files (*.PCF) from AutoCAD Plant 3D, SmartPlant, PDS,
CADWorx, and other software can be imported into Arrow. These options are
all accessed from the File Menu.
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Gas mixtures using NIST REFPROP and Chempak

The NIST REFPROP and Chempak fluid libraries support gas mixing in two
forms. First, users can create their own mixtures. These are called pre-mixtures
because they are defined before the model is run. Second, as flow streams of
different compositions mix together, a new gas mixture results. Its composition
depends on the composition of the incoming streams as well as the relative flow
rates. Since in general the flow rates are not known by the user, Arrow updates
the composition of this new mixture as the simulation progresses. For this reason
these mixtures are referred to as dynamic mixtures. Arrow is restricted to non-
reacting gas mixture calculations.

The ASME Steam Tables library

The ASME Steam Tables Library offers users access to fluid properties obtained
from the IAPWS Industrial Formulation 1997 for the Thermodynamic Properties
of Water and Steam (ISPWS-IF97). This library is selected by choosing the
option at the top of the Fluid panel in Analysis Setup, at which point it is
automatically displayed in the Fluids in Current Model area.

Separator junction

Arrow offers a separator junction. This junction type allows you to separate
fluids out of a mixture, but requires either the NIST REFPROP or Chempak
fluid library to be used in the model.

Fitting library

Arrow offers a library of about 400 fitting losses that can be added to pipes.

Libraries

Junction components and pipe materials can be saved to libraries for later reuse.
Libraries can be located on local PCs or deployed across local or wide area
networks. The Library Manager allows users to connect to relevant libraries for
their specific pipe system design.

Varied pipe geometries including rectangular duct

Five different pipe geometries can be modeled in Arrow. The default geometry
is the cylindrical pipe. The other four geometries are the rectangular duct, the
cylindrical annulus, the noncylindrical pipe, and the helical tube.

Sonic choking

Arrow models sonic choking in complex pipe systems and accurately predicts
the resulting choked flow rate. In addition, Arrow can accurately calculate
multiple choking points in the system.
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Rotating systems for turbomachinery

Arrow allows users to specify rotational velocities such as those experienced in
turbomachinery. Arrow uses this information to determine the varying
acceleration body force on each individual pipe as determined by the laws of
rotational dynamics.

Elevation changes

Arrow uses elevation differences between junctions to calculate hydrostatic or
gravity pressure changes in a system. This can be especially useful for high
density gases with moderate elevation changes or pipe systems with significant
elevation changes such as those found in overland natural gas pipelines, gas
piping for deep mining operations, and HVAC in high rise buildings.

Relief system modeling

Arrow provides support for modeling relief systems, including relief valve
junctions and support for ANSI/ISA Cv loss coefficients. Sonic capabilities
allow modeling of high velocity conditions often found in relief systems.

Control valve modeling

Arrow can model four types of control valves. They are Pressure Reducing
Valves (PRVs), Pressure Sustaining Valves (PSVs), Flow Control Valves
(FCVs), and Pressure Drop Control Valves (PDCVs).

Variable speed compressors and fans

Arrow allows you to model controlled compressors or fans where the control
parameter is flowrate, discharge pressure, or suction pressure. The compressor or
fan speed is varied to meet the setpoint.

Heat of compression

Arrow allows users to choose several different compression models for
compressor junctions. The compression process models how the heat of
compression affects the gas temperature, which is especially important in
compressor applications.

Insulation on inside of pipe/duct

Insulation can be placed on the inside of a pipe or duct, and the effect of reduced
flow area on the pressure drop will be automatically determined. If modeling
heat transfer, the effect of the insulation on the inside will be accounted for.
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Model heat transfer between loops and across programs

Heat transfer between loops which are hydraulically isolated can be modeled.
The loops can have different fluids. This is called thermal linking. The Heat
Exchanger Linking feature in Fathom and Arrow streamlines the thermal
analysis of liquid-gas heat exchangers by allowing direct thermal connections
between heat exchanger junctions in gas (Arrow) and liquid (Fathom) systems.
This integration enables both applications to run simultaneously until a
converged solution is reached, eliminating the need for manual iterations. By
automating this process, users can significantly reduce errors, complexity, and
the time spent on iterative adjustments.

View input and output data from different scenarios concurrently

Input data from ancestor scenarios can be viewed concurrently in the Model
Data window. Similarly, output data from different scenarios can be viewed
concurrently in the Output window.

Compare input from different scenarios

The Scenario Comparison Tool can be used to compare pipe, junction, and
general model file inputs for any number of scenarios in the model file. This
allows the user to quickly identify differences between scenarios, or to generate
a report on inputs for different cases. Comparisons can also be made within the
Workspace using Scenario Comparison Layers.

Design Alerts

Design Alerts can be created for pipes and junctions to alert the user that one of
their project constraints has been violated. A common use is maximum and
minimum allowed operating pressure. If the resulting value for that parameter
violates the Design Alert a warning message is given in the Output. Design
Alerts and violations may also be viewed on the Workspace with Design Alert
Layers.

Cost calculations

Material, Installation, and Maintenance costs can be calculated for junctions,
pipes, and fittings based on Cost Libraries which are user-created. In addition,
energy (operation) costs can be calculated for compressors/fans. Time value of
money can be taken into consideration by entering inflation and interest rates.
The results are presented in a Cost Report in the Output.
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Retaining and reproducing graphs

Comprehensive graphing features allow users to graph a wide variety of
parameters at single points or along flow paths within their model. Graphs added
to a Graph List are saved so that the graph can be regenerated with the same
styles and customization if changes are made to the model input, or if the user
desires to plot the same graph in multiple scenarios. Multiple graphs can be
shown at the same time. Graphs can be displayed on the Workspace with the
Graph Annotation Tool.

Parametric Study Tool

The Parametric Study Tool enables rapid and in-depth simulation analysis,
allowing users to explore a wide range of input parameters efficiently. By
systematically varying inputs, the tool helps identify critical factors affecting
system performance, enhancing sensitivity analysis and optimization. Engineers
can gain clear insights through graphical trends, even in cases where traditional
goal-seeking methods struggle. This approach facilitates better decision-making
by providing visual justifications for key trade-offs, such as cost versus
performance.
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